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Document information

Document information

If you use this guide, please let us know at imadocs@centurylink.com. We
welcome your feedback on this document.

The versions of this guide for the new release are listed below:

Document date Description

March 26, 2012 Draft guide for CMP review posted at

[draft] http://www.centurylink.com/wholesale/cmp/review.html
April 2, 2012 Final guide posted at

http://www.centurylink.com/wholesale/cmp/
review_archivesystem.html

April 23, 2012 Final guide posted at
http://www.centurylink.com/wholesale/ima/gui/index.html

You can find guides for prior releases at
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html.

Change log

Changes to IMA for this release are provided through CMP (change
management process) at http://www.centurylink.com/wholesale/cmp/
index.html.

CMP revisions specific to this guide are as follows:

e Updated the document with the Java Runtime Environment version change
from 1.4.2_xx to 1.6.0_xx.

e One more entry is added to the Java Policy File to support Java Runtime
Environment 1.6.0_Xxx.

« Java Policy File and Java Policy tool images have been changed.
Other changes for this release:

< ‘Downloading the Java Plug-in section’ has been changed to ‘Java Desktop
Runtime Environment for IMA'.

Copyright and Trademarks

©2001-2012 CenturylLink, Inc. All Rights Reserved. The CenturyLink mark,
pathways logo and certain CenturyLink product names are the property of
CenturyLink, Inc. All other marks are the property of their respective owners.
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Getting started

This guide provides
- Dbasic information about Interconnect Mediated Access (IMA)
- software and hardware requirements
e instructions for
- configuring Internet Explorer
< modifying the java.policy file
= Internet access to IMA
This guide is intended for employees of the ISC (Interconnect Service Center),

IWSC (Interconnect West Service Center), the LOC (Listing Operation Center),
and Competitive Local Exchange Carriers (CLECS).

This guide assumes you have a background in telecommunications local
service.

IMA is available for use by CLECS in the legacy Qwest territories within the
former 14-state Qwest region.

CenturyLink SYADs

CLECs

April 2, 2012

CenturyLink™ system administrators create IMA accounts for all CLECs,
including establishing the first CLEC system administrator and maintaining
user profiles.

CLECs interact with IMA on two levels:
e administrators create and manage all CLEC user accounts
e users manage all service requests through IMA

IMA allows CLECs access to local service elements of the CenturyLink network
and electronic access to its legacy operations support systems (OSS).

CLECs use IMA to create local service requests (LSRs) and submit them to
CenturyLink for processing. LSRs contain the information CenturyLink needs to
create service orders for the CLECs.

http://www.centurylink.com/wholesale/cmp/review_archivesystem.html
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System security

System security

IMA provides a secure environment for its users.

System security Description and access

Username and password IMA usernames and passwords for CLEC system
administrators are obtained from a CenturyLink system
administrator. CLEC system administrators must receive
these before they can access IMA.

CLEC system administrators give CLEC users their
username and password. To ensure security, new users
should change their individual password the first time they
log in to IMA. (See “Changing your password” on page 21.)

You can change your password at any time. (System
administrators can also reset passwords.)

User PIN and Corporate ID PINs and IDs are obtained from a CenturyLink Wholesale
Markets service manager. Only users who have these
credentials can enter the IMA secure environment and
access its data, preventing unauthorized persons from
gaining access to protected information.

IMA provides an additional level of security by letting the CLEC system
administrators decide the access rights users will need—administrator
privileges or user privileges. Access rights define specific privileges users have
to operate within IMA. If a user performs the tasks of both an administrator
and a user, this user requires two IMA usernames and passwords, one as a
user and one as an administrator.

An administrator can inactivate a user when necessary, preventing the user
from accessing IMA and data stored in any of the databases. For more
information on CLEC system administrative privileges, see the CLEC System
Administrator’s Guide (http://www.centurylink.com/wholesale/ima/gui/
index.html).

IMA hours (Mountain Time)

Monday—Friday 6 a.m. to midnight
Saturday 6 a.m. to 9 p.m.
Sunday 11 a.m.to 7 p.m.
April 2, 2012 5
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Additional resources

Additional resources

Web sites
IMA Access

https://ima.centurylink.com/ima

Products and Services

http://www.centurylink.com/wholesale/pcat/index.html

CenturyLink E-Business—Digital Certificate Procedures

http://ecom.centurylink.com

Wholesale Customer Contacts business procedure

http://www.centurylink.com/wholesale/clecs/escalations.html

Wholesale Resources—IMA

http://www.centurylink.com/wholesale/ima/index.html

Documents

In addition to this document, CenturyLink provides four other guides to help
you use IMA.

The first three guides are available at
http://www.centurylink.com/wholesale/ima/gui/index.html

e CLEC System Administrator’'s Guide—guidelines for managing CLEC users
accounts

e Facility-Based Directory Listings Guide—qguidelines for submitting orders
for facility-based directory listings

« IMA User’s Guide—guidelines for preparing, submitting, and following up
on LSRs

The fourth guide is available at
http://www.centurylink.com/wholesale/training/coursecatalog.htmil:

e Loop Qualification and Raw Loop Data CLEC Job Aid—qguidelines for
retrieving raw loop data and for checking whether a loop qualifies (for
CenturyLink HSI/Broadband Service or for unbundled ADSL service)

April 2, 2012 6
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Requirements

This chapter describes hardware and software requirements for IMA. If non-
IMA applications are running concurrently with IMA, these requirements may
need to be increased.

Note: When a new version of IMA is installed, you must log out of IMA
and log back in to continue working.

Software requirements

Important: CenturyLink only supports and certifies Windows XP as the
operating system for IMA. CenturyLink recommends you
use Internet Explorer 7.0 as your browser when running
Windows XP. IMA may function using different browsers and
Windows operating systems, however, CenturyLink will not
be responsible for any problems encountered when using
operating systems other than Windows XP.

Microsoft Windows XP
Internet Explorer 7.0 (recommended)

Java Runtime Environment 1.6.0_xx or higher for Internet Explorer.
However, CenturyLink recommends that Internet Explorer users upgrade to
java Runtime Environment 1.6.0_30.

Hardware requirements (minimum)

April 2, 2012

Intel Pentium 233 MHz

17-inch SVGA monitor (800 x 600 resolution or higher)
SVGA video card with 2 MB memory

96 MB RAM

56 Kbps modem or dedicated LAN connection to CenturyLink

200 MB free disk space (after all software installation and Windows virtual
memory file allocation)

http://www.centurylink.com/wholesale/cmp/review_archivesystem.html
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Java Desktop Runtime Environment for IMA

Additional memory (RAM) and a faster network connection and CPU may
improve performance of IMA.

Java Desktop Runtime Environment for IMA

IMA is certified for Java Runtime Environment (JRE) 1.6.0_30. Please contact
your desktop support if you need the Java RE for your desktop.

The Java Desktop Runtime Environment (JRE) can be found at

http://java.com/en

If the Java Desktop JRE has not already been installed, a Java Runtime
Environment Not Installed popup window appears in IMA GUI. This appears
only when PreOrder/Order/PostOrder is launched for the first time and the
Java Desktop Runtime Environment has not been installed.

Note: It might be possible for an unsupported browser to run the
PreOrder/Order/PostOrder GUI after the Java Runtime
Environment has been installed. If you encounter problems,
however, CenturyLink first recommends that you install IE 7

browser.

April 2, 2012
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E-business Internet connection

CenturyLink E-business digital certificates (or digital IDs) are issued for each
of your employees. They are required for each personal computer used to
access CenturyLink systems via the Internet.

E-business digital certificate registration is a one-time process and must be
renewed every five years.

You must first request a digital certificate before starting the registration
process.

Requesting a digital certificate

April 2, 2012

The CenturyLink E-Commerce group obtains the VeriSign and legacy Qwest
cobranded digital certificates needed to access IMA via the Internet.

The digital certificate process is administered by the CenturyLink WSSA
(Wholesale Systems Security Administration) group. This group has
responsibility over these certificates for end users, including revocation of a
certificate and updating user information.

To request a digital certificate

1 Contact your CenturylLink service manager at:
http://www.centurylink.com/wholesale/clecs/accountmanagers.html

Note: You may also go to the Wholesale Systems Web site at
http://www.centurylink.com/wholesale/systems/
generalinfo.html for request information and forms.

2 Fill out the digital certificate request form.

E-mail the completed form to your CenturyLink service manager.

The CenturyLink service manager verifies that the information is complete
and correct and then forwards your request to WSSA. The WSSA sends
your information to ECOM to assign the certificate and PIN information.

Important: All digital certificate requests must go through a
CenturyLink service manager. Under no circumstances
should you e-mail your request directly to the CenturyLink
Wholesale Systems Security Administration group. Your
request will not be processed.

http://www.centurylink.com/wholesale/cmp/review_archivesystem.html
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Downloading your digital certificate

Once your request is processed, the information is updated in the LDAP server
and an e-mail reply is sent to you. Please allow a minimum of 48 hours to
process and update security databases.

The e-mail contains the following information you must have before registering
your digital certificate:

- digital certificate number
e PIN

« instructions for their use

Once you’ve registered your digital certificate, you must have the following
before you can access IMA:

e your company’s corporate ID
e username

e password

Downloading your digital certificate

To begin the downloading process

1 Go to the CenturyLink Online Service Center Web site at (http://
ecom.centurylink.com).

= Qwest | Large Business | Online Service Center Main Page - Windows Internet Explorer g@g\
& )~ Bl hpsifscon.centurying con o (4] [x ol

© Fle Edt  WView Favorites Tools  Help

G 2 B = z - »
W | Quest | Large Business | Online Service Center Main ... | a8 o - |z Page = () Tools -

LOCAL PHONE SERVICE INTERNET WIRELESS LONG DISTANCE DIGITAL TV © QwestControl
Manage My Account
Q CUSTOMER SERVICE SEARCH
Qwest

HOME = RESIDENTIAL ;| SMALLBUSINESS = LARGE BUSINESS : PARTNERS = WHOLESALE [

Products & Services | Solutions by Industry | Request Information | Manage Your Account | Customer Service

LARGE BUSINESS SERVICES

Online Service Center Getting Started

» Begin Digital Certificate . . N
Download Process What is the Online Service Center?
i = What Tools are Available?
O e R e Why Do I Need a Digital Certificate?
» Privacy Policy What if I have Questions?
How Much Does it Cost?
Will My Information Be Kept Private?
v
< | b

& @ Irternet #100% ~

2 From the Online Service Center menu, select Begin Digital Certificate
Download Process.

April 2, 2012 10
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Downloading your digital certificate

Important: Digital certificates must be downloaded within 30 days of
receipt. Digital certificates not downloaded within this time
are removed from the system. If your digital certificate has
been removed, you must request a new one.

= Centurylink OneStep Certificate Enroliment - Windows Internet Explorer,

@‘(J - [&] httpsifjcerts. conturylink.comfenvol_msie_qwest _v5.html M & ][42) (] [Lve searcn

© Fle Edt  WView Favorites Tools  Help

* & [(gcenturyunkonestepcertmcateEnro\lment [ } iR -2 &

CenturyLink~

CenturyLink OneStep Certificate Enroliment

Step 1: Information for your Digital ID

The information that you enter here is used to create the public portion of your Digital ID. Fill in all

fields

Step 2: Cryptographic Service Provider

The options in the Cryptographic Senice Provider drop down box are based upon the canfiguration
of vour machine. Choose one of the Microsoft aptions listed below. We encourage vou to choose

v

Done

@ Irternet

#100% -

3 Fill in the User ID and PIN fields and click Accept.

Note: The private key is used by Internet Explorer to encrypt data that
is transmitted from the CLEC to CenturyLink. It is stored only
on the workstation and browser version from which the
key was generated. Multiple digital certificates may be stored
on a single workstation. However, if another workstation or a
different browser version is used, a new private key must be
generated and stored on that workstation.

4 Click Yes if you receive an ActiveX Control warning.

Fatential scripting Vielation

a

ouda nok Enust bo run on this compuber ared gain access b your data,

i yous weant this program bo add the certificates now? Clck Yes F you brust this Web ste. Otherwise, chok No.

= e

Thes Wb site b sdding one or more cartificabes o this computer, Allwing ah unbnasted Wb st to updsts your
certificates s & seounty risk. The 'Web sbe could irstall certificates you do not trust, which could allows programs that

5 Click Yes at the security warning to proceed with installation.

Security Warning .

&

You are about to install jthority (CA) claiming

Quiest Communications International Inc Root CA v1

Windows cannot validate that the certificate is actually From "Quest Communications International Inc Root CA v1".
You should confirm its origin by contacting "Qwest Communications International Inc Root CA v1°, The Following
number will assist you in this process:

Thumbgprint (shal): CC6CSBIE FIAZBEGC 4ASEBISE 27D256C1 BS6ARATE

Warning:

IF you install this root certificate, Windows will automatically trust any certificate issued by this CA. Installing a
certificate with an unconfirmed thumbprint is a security risk. IF you click "Yes" you acknowledge this risk.

Do you wantk to instal this certificate?

April 2, 2012
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Verifying the installed certificate

When the client digital certificate is fully loaded on the workstation, the
registration process is complete.

otian - Windows ntereet Explorer

CenturyLink OneStep Certificate Enroliment | N NN

Enroliment Complete

Congratulations!

Your certificate has been generated
Diepending on the version of Windows you
a1 USing, you may fecens a0 Active
‘Control viarning, Seledt yes' for the ActiveX
Control waming

Seloct Vs’ for ‘Do you Wt INS program o
‘add the certificata now?

Your certificate has been downloaded and installed into your Web brawser.

Copymght ©2011 CentuyLik AN Rights Resarved | Ligal Noties | Py Poicy

Gt o -

Verifying the installed certificate

April 2, 2012

1 Choose Tools > Internet Options in your Internet Explorer browser.
& carn ernet Explorer =)

2 On the Content tab, choose Certificates.

Internet Options

General | Security | Privacy | Comkent | Connections || Pragrams | Advanced

Conkent Advisor

Ql R.atings help wou contral the Internet content that can be
wigwed on this computer.

Certificates

A

[ Clear 551 skate ] [ Certificates ] [ Publishers

IJse certificates For encrypted connections and identification.

AutoComplete

http://www.centurylink.com/wholesale/cmp/review_archivesystem.html
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3 Double click on the certificate’s name.

a4

Certificates

Personal |Other People | Intermediate Certification Authorities | Trusted Root Certificatior € *

Issued To Issued By Expiratio...
[Elquest Communicati... ECOM User CA 9/12/2016

Friendy Name

<None

Certificate intendzd purposes

Close

View the General tab.

Certificate

General | Details | Certification Path

B
Certificate Information

This certificate is intended for the follawing purpase(s):
~ll application policies

Issued to: Qwest Communications International Inc
Issued by: ECOM User CA

valid from 9/13j2011 to 91z/2016

% wou have a private key that corresponds ta this certficate

5 View the Certification Path tab.

Certfication path

General | Detalls | Certficationpath |

(west Communications International Tnc Rook CA vi

Certificate shatus:

This certificate is OK.

3—E-business Internet connection

Verifying the installed certificate
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Modifying the java.policy file

Modifying the java.policy file

Important: CenturyLink highly recommends that you create a backup
copy of the java.policy file.

1 Using Windows Explorer, access the java.policy file from the folder
C:\ProgramFiles\Java\jrel.6.0_ xx\lib\security (where xx is either 25 or 30.
If you have folders for both jrel.6.0_ 25 and jrel.6.0_30, use the 30
folder).

2 Select the java.policy file.

3 Select Edit = Copy, then select Edit > Paste.

A copy of the java.policy file appears in this same folder.
B =1o] x|

Ele Edit View Fg\;uritzs Iools Hep a
Qo - ) - ¥ |/'f\.5u.-m ‘”_' roders | [ (37 X Z)‘-

Address () C:\Program Flles\Java\re 1.6.0_30Vblsecurity =B

Foiders * o — T4 ocal_polcy.jar =]
blacklist local_palicy. jar
B4 jre1.6.0_30 N (&) | Excciteble 2o e

B-£3 bin

=E{»
j applet E fa?er's java.sequity
sudo | T | B
S oo EEH | =
&) deploy
Chext
Q) fonts
i386
i
(0 images
(2 management
£ seaurity
(0 servicetag
i o
8- microsoft frontpage

#-{23) Microsoft Office = =
Ll Sl | »

Type: POLICY Fie Date Modified: 1/11/2012 10:34PM Size: 2.20KB  [2.20KB | i My Computer =

4 Using WordPad, open the java.policy file.

B javapolicy - WordPad
G £t Vew [wet Fomst Heb

DilE] SRl sl % 5a)-| %

permizsion java.net.SccketPermission "localhost:1024-7, "listen™: :‘l
permizsion jave,net.SocketPermission "suomteBi.dev.gincea.com:B00-", "connect, resolve™:
PErmisSsion jave.net.ScckerPermisslon "SuomTESL.dev.gincEa.comsB00-", TCORNect, EesolveT!
PECmisS1on javae.net.SocketPermassion "suomd?ili.dev.qincea.come@0l-", “connect, resolveT;
permizsion java,net.focketPermission “ruomtéfi.dev.giotoe, comiB0l-", “connect, cesolve™:
permizsion jave,net.ScocketParmission "suomtddi.dev.gintes.com:B0i-", "connect, cesolve™:

£/ "standard® properies that can be read by anyone

PECmISSION Java.utll.FroperiyPermission "java.version®, "read”:
PEIMIZS10Nn jave, utll.PropertyPermission "java.vendor®, “read®s
permizsion jave,util.PropertyPecmission "java.vendor.ucl®, “read®;
permission jave.util PropsrtyPecmission "jave.cless.vecsion®,
permizsion jeve.util.PropertyPermission "os.name", “rend™;
permission jeva.util.PropertyPermission "oa.version®, "read®;
permission java,.util.PrepertyPecmission "os.arch”, “cead™;
PETRISSION JAVA.util.PEopartyPeEmiasion "file,.SEpAratoE”, “read™:
PECMISSION Java.utll.FroperiyPermissicon "path.separatce”, “read™:
PEIMIES10n jave, utll.PropertyPermission "line.separator”, “read™;

permisston jeve.util PrepertyPecmission "java.specificacion.vession®, “eead”:
permission jave.util.PropercyPermission "java.specificacion.vendor”, read":
permission jevae.util.PropertyPermission "javae.specification.name”, “read:

PETHISSLON JAVA, ULl PECPETTYPEEELANLOR "IAVA.VE, SPECITICATION . VECALON", "Tead™;
PECmISSLON Java.UCll.PECPErTyPermlasion "jave.ve.specification.vendor™, "read®)
PEIMIES10n jave, utll.PropertyPermission "java.vm.specification.name®, Tread®;
permizzion jave,util.PropertyPecmission "java.vm,version®, “resd®:

permission jeve.util FropsrtyPecmission "jave.vs.vendor®™, "read®:

permizsion jeve.util.PropertyPermission "jave.vm.name®, "read®;

L

Ji 1

For Help, peess FL

5 Edit the java.policy file by adding the following 3 lines:

April 2, 2012 14
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Modifying the java.policy file

e permission java.util.PropertyPermission "javax.net.ssl.*", "read,write";
e permission java.util.PropertyPermission "user.home", "read";
e permission java.lang.RuntimePermission "setFactory";
Insert these lines at the bottom of the file just above the }; symbol.
Tip: If you're reading these guidelines in Adobe Acrobat, you can use
the Select Text tool to select the lines of text, copy them, and

paste them into the java.policy file. Copy and paste one line of text
at a time eliminating the leading bullet.

6 Save and close the java.policy file.

If you are unable to access the IMA PreOrder/Order/PostOrder functions after
completing the above procedure, do one of the following:

< If you do not receive an error message, close all active windows and
programs and restart your computer.

- If one of the following error messages displays, follow the instructions and
try accessing IMA PreOrder/Order/PostOrder again:

Error Message @

@ Internet Access Problem - A problem occurred with System Permissions.

Please review instructions:

Check the policy file to ensure the following lines have been added:
ion java.util.Property ission “javax.net.ssl. ", "read,write";
ion java.util.Property ission “user.home", “read";

Jawa Applet Window

If this error message displays, check the java.policy file and make sure the 3
new additional lines you entered are accurate and placed correctly.

Error @
Messages:

There is an error in the certificate password you entered or in the name of the certificate. ~
Please see the instructions in the Manual.

~

< >

0K Print Praview E-mail
‘JavaAppleledDw

If this error message displays, check to make sure the certificate password
and name are correct. The password is one you previously entered for the
certificate or qwestl. The certificate name in your UserlID folder must be
QwestIMACertificate.pl12.

Note: For digital certificate assistance, call the CenturyLink Wholesale
Systems Help Desk (888-796-9102, option 2).

April 2, 2012 15
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Importing your digital certificate to Internet
Explorer

This section is for current and new Internet Explorer users and explains how to
“move” your digital certificate.

All requirements for modifying the java.policy file must be completed before

continuing.

1
2

4

April 2, 2012

http://www.centurylink.com/wholesale/cmp/review_archivesystem.html

Open Internet Explorer.

From the Tools menu, select Internet Options.

Click the Content tab.

Internet Options 21
General | Security | Privacy | COMtent | Connections | Programs | Advanced

Content Advisor
Riatings help you control the Inkernet content: that can be
viewsd on this computer.,

=]

Certificates
Use eertificates for encrypted connections and identification

[ clearssistate ][ cortficates  |[ Publishers |

AutoComplste

:? AtoComplete stores previous entries Settings
=]

on webpages and suggests matches
ar Yo,

Feeds

Feeds provide updated content from Settings
&l

websites that can be read in Internet
Explorer and other programs.

Click Certificates.

Cortificates P

Cireon

Certificate intended purposes

endedpurcse: | E I

Personal | Other People || Intermediate Certification Authorities | Trusted Root Certificatior € *

Issued To Issued By Expiratio... | Friendly Name

(s |

dose

3—E-business Internet connection
Importing your digital certificate to Internet Explorer
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3—E-business Internet connection

Importing your digital certificate to Internet Explorer

Click Import to activate the Certificate Wizard.

Certificate Import Wizard X

Welcome to the Certificate Import
Wizard

This wizard helps you copy certificates, certificate trust
lisks, and certificate revacation lists from vour disk ko &
certificate store

& certificate, which is issued by a certification suthority, is
a confirmation of your identity and contains information
used ko protect data or to establish secure nebwork.
connectians, A certificate store is the system area where
certificates are kept.

To continue, clck Next,

Cancel

Click Next.

Certificate Import Wizard X

File to Import

Elle name:

Speify the file you want to impart,

Neke: More than one certificate can be stored in a single fil in the Follawing formats:
Fersonal Information Exchange- PKCS #12 { PR, .F12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates {P7E)

Microsoft Serialized Certificate Store (.55T)

Browse...

[ <gack [ mest> | [ concel |

Type the URL or select Browse to locate your certificate. Your certificate
should be located at C:\Documents and Settings under your specific
UserlID and the file name of the certificate should be
QwestIMACertificate.pl2.

Click Next.

Certificate Import Wizard

Password

Password:

To maintain security, the private key was protected with a password.

Type the password for the privats key.

T

Enable strong private key protection, You will be prompted every time the
bl ki Il b d th
private key is used by an application if you enable this option,

[CMmark this key as exportable. This will allow you to back up o transport your
keys ata later time.

(<o | o> ] [ ot ]

In the Password field, type gwestl. This password is case-sensitive.

17



3—E-business Internet connection

Connection Guide—IMA 32.0
Importing your digital certificate to Internet Explorer

10 Click Next.

Cartificate Impert Wizard

Cerlificale Store
Certficate stores are system aress where certificates are kept,

Wincows: can automatically sokect a cortifica . or you can sgecify a beation

O Automatically seiect S cortificatn « ed on e typer of certificatn

EIPlacn ofl cortificates: in the foliowing store

Certificata store:

reer

l < Rack " Hanet = ]l Carcal ]

11 Leave the settings at their default positions and click Next.

Cartificate Import Wizard

Completing the Certificate
Import Wizard

Yoas b saccsslly compieterd the Cortificat Trport
wizard

Yiou v sgecifioed S following sttings:

Certficate Store Salected by User  Persanal

Content FFx

File Narne CADoouments and 5

< *
pack || Frsh | [ cancel

12 Click Finish.

Certificates

Intended purpose:

Persanal |Other Peaple | Intermediate Certification Authorities | Trusted Roaot Certificatior ¢ *

Issued Ta Issued By Expiratio...  Friendly Mame
Qwest Comrmunicati,.. ECOM User CA 4212013 <Nonex
Qwest Comrmunicati,.. ECOM User CA 424/2013  <Nonex
Qwest Comrmunicati,.. ECOM User CA 9/15/2013  <Nonex

Certificate intended purposes

Close

The name of the certificate appears in the Certificates list box along with
a confirmation message.

13 Click OK and close all active windows.
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Connecting to IMA

If you are accessing IMA over the Internet, several factors external to
CenturyLink (such as your Internet service provider—your ISP—and Internet
traffic) may impact response time.

If you're accessing IMA using a digital certificate, use this URL: https://
ima.centurylink.com/ima. (CenturyLink recommends that you bookmark this

URL.)

Logging in to IMA for the first time

April 2, 2012

The Interconnect Login window ensures that only authorized users access
IMA. To log in, you need your corporate 1D, username, and password. (You can
get this information from your system administrator.)

See “System security” on page 5.

Interconnect Login

Interconnect
MedIated
_Access

Enter your Corporate ID, Username and Password then Click 'Login'.

Corporate ID:
Username g
Password:

Clear

1 In the Interconnect Login window, type your corporate ID, username,
and password. (These fields are case-sensitive.)

2 Click Login.

The first time you log in to IMA, your password is the same as your
username. As soon as you create your personal profile, you should change
your password. (See page 21.)
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Connection Guide—IMA 32.0

Creating your personal profile

April 2, 2012

4—Connecting to IMA
Creating your personal profile

The first time you log in to IMA, you must fill in your personal profile before

CenturyLink uses to contact you.

you can go on to other tasks. Your personal profile contains information that

Tip: Administrators—you might want create a joint e-mail account and
phone number so that all users have access to this e-mail or phone
number in case of absence, emergency, or work flow. This group
e-mail and phone number can then be entered in the individual

user’s profile.

@v e o] [ 4] ol
Fle Edk Vew Favortes ook Help
T o frome - dmeane - [rpage + ) Took + (@) Hep -

Either an Email address or valid Fax Number is required as part of the User Profile information.

Personal Profile

Name:
Telephone Number:
E-Mail Address:
Fax:
Street Address:
Floor:
Room/Mail Stop:
City:

State: |[AL v
Zip/Postal Code:

[ Update Database ” Logout ]

&3 Local intranet. &, 100%

1 Fill in the fields. (Floor and Room/Mail Stop are optional.)

a For your telephone and fax numbers, use the format 555-555-5555.

b Fill in your e-mail address, fax number, or both to indicate how you

want to receive system notifications.

2 Click Update Database. (If you click Logout, your profile won’t be saved
and you'’ll still need to create your personal profile next time you log in.)

3 Click Return to Main Menu.

The Interconnect Functions window appears. Depending on your access

level, you may see fewer options.

Interconnect Functions

System Administration
User Administration

Set CUID
PreOrder/Order/PostOrder
Status

Line Loss

Baich Hot Cut Status
Firm Order Manager

Lock Administration
Resource Return

SOV Recent Page Report
Yirtual CSR

View Reference Data
Logout

http://www.centurylink.com/wholesale/cmp/review_archivesystem.html
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Connection Guide—IMA 32.0 4—Connecting to IMA
Modifying your personal profile

Important: Be sure to use buttons within IMA. Don’t use the browser’s
buttons (e.g., Back) or you may get an error.

Modifying your personal profile

After you have created and saved your personal profile, you can modify it
further as needed.

1 In the Interconnect Functions window, click User Administration.

{2 Personal Profile - Windows Internet Explorer =153
@ , ~ e o |[#2] [ x Pl
Fle Edt View Favortes Tools Help

i 4 fvome - APt - [rPage - 0 Tooks - @) Hep -

Personal Profile

Name: IMA Documentation
Telephone Number: |111-222-3333
E-Mail Address: imadocs@qwestcom
Fax: 123-456-7890
Street Address: 930 15th Street
Floor: |5
Room/Mail Stop:
City: Denver
State: CO v
Zip/Postal Code: 30202

Update Database

Return to Main Menu

% Local intranst 0%

2 Click in each field to be modified, and change the information. (Remember
to use the format 555-555-5555 for the telephone and fax numbers.)

3 Click Update Database.
4 Click Return to Main Menu.

Changing your password

For security reasons, you should change your password often.
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Connection Guide—IMA 32.0 4—Connecting to IMA
Changing your password

1 In the Interconnect Functions window, click Set Password.

{2 Set Password - Windows Internet Explorer

Go- & TBE leD)

Fle Edi WView Favortes Took Help

T & {GHome - gmPint ~ [Page + i Took + @) Help -

Set Password

Enter New Password.

Old Password:
New Password:

Re-Type New Password:

Return to Main Menu

2 Do the following:

In this field ... Type ...

Old Password Your current password

New Password Your new password (6—8 characters, at least one of which is
a number or special character)

Re-Type New Password

3 Click Set Password.
IMA changes your password.
4 Click Return to Main Menu.
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